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Course Objectives 

• Overview of the NBRSS and NBS

• Overview of Accounts Payable

• Accounts Payable Inquiry

• Important Dates and Activities 
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Agenda

1. Discuss NBRSS and NBS Project
2. Overview of Accounts Payable
3. AP Inquiry
4. Wrap Up
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Training Guidelines 

1. Ask Questions

2. Cheating is encouraged

3. Don’t let me get ahead

4. Have fun!
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Accessing Oracle via the NIH Portal

Oracle is a web-based application available via the NIH Portal

NIH Portal website:  http://my.nih.gov
To Log on use your:

NIH Domain
User Name
Password

For assistance, contact NIH Help Desk at 6-HELP (301.496.4357).

Add the Budget & Finance Community, which is the page where the 
Oracle application resides
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Logging in to the NIH Portal

 
Follow steps below to access the NBS Travel System application from the NIH Portal. 
• Launch Internet Explorer.  In the browser, navigate to the NIH Portal at http://my.nih.gov. 

(Note: If you need Internet Explorer installed on your computer, please contact the NIH Help 
Desk at 6-HELP (301-496-4357)  

• Sign in to the NIH Portal according to the steps listed below, using the account information 
you currently use to log on to Windows at your workstation. 

• Select your domain from the pull-down menu. (Hint: Use the "Which 
domain should I select? link for assistance.)  

• Enter your User name. 
• Enter your Password. 
• Click the Log in button. 

 
For Portal account and password assistance, contact the NIH Help Desk at 6-HELP (301-496-

4357). 
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Adding a Community to your NIH Portal View

1

2

3

4

5

 
What is a Portal Community and how do I subscribe to a Portal Community? 
 
Portal Communities provide content, documents and application access to users who have a 
common area of interest.  Once you subscribe to a community, it will appear in the list on your 
Communities tab every time you visit the NIH portal.  Follow the steps below to subscribe to a 
community. 
 

•  Click on the “Communities” tab and select “Edit Your Memberships”.  
•  Locate a community of interest either by clicking a folder to browse for communities or 

by entering a key word in the Search field and clicking "Go" to look for a specific 
community. 

•  Once you locate a community of interest, select it by clicking in the box next to the 
community name. 

•  Click “Add to my Memberships”. (You may need to select your default community.) 
•  Click “Finish”.  The subscribed community will now appear in the list on your 

“Communities” Tab every time you access the portal.  
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Questions

Questions?
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How to Use the Manual

Each Student Guide contains a Table of Contents
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How to Use the Manual

Each Chapter constitutes a lesson
Each lesson has a set of objectives
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How to Use the Manual

The lessons contain information on the business processes as well as 
step-by-step instructions on how to perform tasks in the NBS
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How to Use the Manual

Step-by-step instructions on
how to perform tasks in the
NBS are contained in
“Navigation” documents.

Navigations:
1. May contain a Purpose or 

Prior Activity section
2. Contain a Navigation Box 

on the first page
3. Contain a picture of the 

screen that you will use to 
enter the data

1

2

3
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Navigation Boxes describe how to get to the appropriate screen in 
Oracle to perform the task

Navigation Boxes are always followed by a screen shot of the window 
you will navigate to.

NIH Receivables Customer Entry Oracle Responsibility

N > Customers > Standard Navigation Path
Find/Enter Customers                                            Screen Name

How to Use the Manual
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How to Use the Manual

1. Directive 
statements will 
help you 
determine your 
next step.  The 
statements are 
indicated in Bold

2. Words in Bold
font indicate a 
field, window, or 
button name

2

1
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How to Use the Manual

The shaded fields indicate that the entry is optional or that you should 
accept the default values

If a field is not referenced, you should not change the default value.
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How to Use the Manual

Notes provided after the task instruction provide useful information or 
helpful hints to complete the step.
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How to Use the Manual

The end of the 
task will be 
indicated by 
End of Activity.
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How to Use the Manual

Each lesson concludes with a Lesson Summary
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NIH Business System (NBS) – How it all 
started

Project began in FY 1999 with the development of a comprehensive business 
case to replace NIH’s Administrative Data Base (ADB).

ADB -- An integrated data base that services most of NIH’s administrative and 
support functions.

Central Accounting, Accounts Payable, Travel, Property, Acquisitions/Supply, 
Contracts, and Service and Supply Fund activit ies.
Transactions feed the accounting system from the point of origin, i.e., 
procurement requisition, travel order, etc.
Used by about 5,000 NIH employees, most of w hom are in the Intramural 
Research Program.
Processes approximately 150,000 transactions each day.

Work groups comprised of 200 NIH employees helped with the NIH decision to 
go with a commercial Enterprise Resource Planning (ERP) product.

The challenge is not to design software but to adapt NIH business practices to 
the “best practices” embedded into the commercial ERP product.
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NBRSS Project Objectives

NBRSSNBRSS

NBSNBS EHRPEHRP

2 web-based systems to provide administrativ e support to NIH’s scientific 
mission
Links the NIH accounting structure with administrative and scientific support 
functions
Incorporates industry standard “best practices”

Integrates NIH’s core administrative functions
Finance – Scheduled Deployment 10/1/03
Travel – Scheduled Dep loyment 9/1/03
Propert y
Acquisition/Supply
R & D Contracts
Service & Supply Fund 

Replaces the current Administrative       
Database (ADB)

Improves Human Resources and benefits 
management and planning across DHHS and 
NIH
Modernizes the processing of Human  
Resources actions
Replaced the DHHS Human Resources 
system (IMPACT)

Deplo yed 
9/9/02!
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Project Manage r
Colleen Barros

(NBRSS)

Functional 
Managers

Leslie Siddeley (NBS)
Jan Maltbie (EHRP )

Technical 
Managers

Carol Perrone (CIT)
Jack Vinner (CIT)

Systems
Integrator

Tom Breue r
(BearingPoint)

Change
Manager

Susan Corey
(NBRSS)

Functional
Team

Membe rs
(NBRSS)

Technical
Tea m

Membe rs
(NBRSS)

Functional, Technical 
and Change 

Management
Team 

Membe rs
(BearingPoint)

Resource Tea ms
(NIH IC/OD )

Change Mgmt
Tea m

Represents formal lines of authority:
•Funct. Teams -NBRSS employees reporting to FM
•Tech. Tea ms -CIT employees reporting to TM
•BearingPoint employees report to SI 
•CM-NBRSS employees reporting to Director
•Each, in turn, reports to Project Manager
•Functional Advisory Committee and Resource 
Team me mbers a re IC/ OD e mployees 
serving on ad hoc basis
•Steering Committe e is top policy making body

Functional Advisory 
Committees

(NIH IC/OD )

Change Management
Advisory 

Committee
(NIH IC/OD )

Administrative Manage ment Systems Stee ring
Committee (A MSSC)

IV&V

NBRSS Governance Structure
20 NIH Le aders+ 1 DHHS Rep.

140 End-users

66 Ma nagers

& Superv isors
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NBS NBS -- An Integrated SystemAn Integrated System

Property Property 

TravelTravel

AP/AR  AP/AR  
PurchasingPurchasing

InventoryInventory

Projects Projects 
R&DR&D

ContractsContracts

(Gelco)(Gelco)

(Sunflower)(Sunflower)
(CompuSearch)(CompuSearch)

(Oracle & CompuSearch)(Oracle & CompuSearch)
(Oracle)(Oracle)

(Oracle)(Oracle)

(Oracle)(Oracle)

(Oracle)(Oracle)

General Ledger / General Ledger / 
Budget ExecutionBudget Execution
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NBS – How it Works
Typically, transactions proceed horizontally across several administrative 
functions.

Administration uses the NBS to purchase a piece of equipment for a scientist.

In real time, this information automatically transmits to f inance to check funds 
availability; obligate funds; and once the equipment is received, pay the bill.

Upon receipt this information automatically f lows to property to track the equipment.

Why an integrated system? 
Eliminates multiple entries;
Minimizes the potential of errors;
Provides accurate reports; and 
Eliminates the expense and technical diff iculty of linking together systems that are 
dedicated to individual functions.
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Expected Benefits of the NBS

One integrated system, linking each of the major 
business functions, including human resources;

Better integration and sharing of information within the 
organization; 

Improved managerial control and access to key data; and

Improved financial statements and management reports 
across NIH, using the new Accounting Classification 
Structure (ACS).
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Realities of the NBS

NBS replaces a dying system – something had to be done.  NBS offers a 
modern-day feel, but no system is perfect, and the NBS will not solve 
everything.

NBS is not a proprietary system – we’re bound by the software, and 
customizations are costly.

There will be a phased conversion period, so we will not experience the full 
functionality and benefits all at once.  As pieces of the current system are 
shut down and the new system is set up, there will be disruption.

The administrative, legal, and regulatory policies outside of the NBS remain.

To reap the full benefits of the NBS, local IC policies and approval levels may 
need to be reevaluated.

The NBS project is not operating independently – it is influenced by various 
Department initiatives.
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Track 1 Activities: General Ledger/Budget

NBS General Ledger replaces the CAS as the system of 
record

New projects (former CANs) are created

Budgets are entered based on the new accounting 
structure
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Sample Track 2 Activities: Travel 

NBS Travel System 
Enter, approv e, and electronically  route trav el documents, such as authorizations and 
v ouchers.

Accounts Payable
Process pay ments to trav elers and trav el management centers f or expenses entered in the 
NBS Trav el Sy stem
Maintain the database of trav elers and banking inf ormation

Accounts Receivable
Establish a list of  sponsors that is ref erenced by  the NBS Trav el Sy stem
Track amounts due f rom and paid by  non-f ederal organizations that sponsor trav el

Cash Management
Reconcile inv oices from TMC f iles to expenses entered in the NBS Trav el Sy stem and 
processed in Accounts Pay able

General Ledger/Fed Admin
Collect data from all f inancial subledgers
Record in-kind contributes from sponsors
Enter manual journal v ouchers
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Lesson Objectives 

After this lesson you should know:

• What Accounts Payable functionality is being used for 
Track 2

• How invoices are generated

• How payments are generated and recorded
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Track 2 Accounts Payable Purpose 

The main purpose of Accounts Payable is to pay individual travelers and 
vendors for travel-related services.

NIH Travel Voucher

Travel er: John Smith

#TR35697-V1

Airfare - $325

Hotel - $200

Per Diem - $100

NIH Travel 
Authorization

Travel er: John Smith

#TR35697-V1

Advance Requested 
- $240

 
The majority of travel-related payments are made to  
•Individual travelers 
•Impac Government Services (for TMC airfare charges) 
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Track 2 Accounts Payable Purpose 

In the event that a person is paid too much, Accounts Payable will be 
used to record the amount due to the NIH and the payments that have 
been received.

NIH Cashier
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Accounts Payable Functionality

In order to process travel-related payments and refunds, the following functions
must be performed:

1. Traveler and Vendor information is 
maintained in the supplier table

2. Supplier bank information is 
maintained in the bank table

3. Invoices and debit memos are 
received, entered and prepared

4. Payments and refunds are 
generated and recorded

Government 
Accounting Branch

Travel and Cashier Offices

Travel Office
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Relationships with other Financial Modules 

Accounts Payable works with many other financial modules

Accounts Payable

Cash
Management

Purchasing

Projects

Fed Admin

General 
Ledger

PO 
Match

Payment 
Confirmation

Project 
Validation

GTA Payment 
Reconciliation

Accounting 
Interface

 
Accounts Payable works with other modules 
 
Purchasing – AP matches invoices to purchase orders located in the Purchasing module 
 
Cash Management – GTA payments located in the AP module are reconciled to the TMC 
invoice in Cash Management 
 
Projects – AP validates project information located within the Projects module 
 
Fed Admin – AP Treasury Payment Batches are confirmed in Fed Admin 
 
General Ledger – All AP accounting information is transferred to the General Ledger 
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High-Level Travel Payment Flows

Patient and Foreign 
Travelers

Traveler

Payment

NBS Accounts 
Payable

NIH Cashier

TMC

U.S. Treasury

Travel Information

Oracle
AP

Invoices and 
Debit Memos

ACH and Check 
Payment Requests

GTA 
Payments

Cashier  Payment 
Requests and Debit 

Memos

Refunds

Travel
Manager

Payment

Refunds

 
Travel-related Accounts Payable payments can be separated into three distinct groups: 
 
•    Payments made directly through US Treasury 
•    Payments made through NIH Cashiers 
•    Payments made on a GTA Account 
 
Each payment group will have its own specific payment process. 
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Travel Document Processing

The diagram below describes when information is passed to the NBS Financial 
Modules from the NBS Travel System

NBS Travel 
System

Accounts
Receivable

General 
Ledger

Accounts
Payable

Purchasing

Obligation

Sponsored 
Invoice

Authorization Related

Voucher Related

Sponsored In- kind

Cash 
Management

Travel er/
GTA 

Invoices

 
Accounts Payable may receive information from the NBS travel system upon the approval of 
both a travel authorization (order) and a voucher. 
 
Approval of Travel Authorization 
If an advance is approved, a prepayment invoice may flow into Accounts Payable for travel 
advances. 
 
Approved Travel Voucher 
After a travel voucher is approved, three documents may flow into Accounts Payable: 
•An invoice for expenses reimbursable to the traveler 
•An invoice for expenses charged through a TMC 
•A debit memo for outstanding advance due to the NIH 
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Accounts Payable Invoices and Payments

US 
Treasury

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices and Debit 
Memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment 
and ref und

• Inv oices are prepared 
f or pay ment

• Pay ment batches are 
generated f or Treasury

• Pay ments and 
Ref unds are recorded 
by Cashier

• Pay ments are 
recorded f or GTA 
Reconciliation

Cash 
Management

• Pay ments are 
reconciled to 
TMC File
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Invoice Import from NBS Travel System

AP Open 
Interface

AP
Invoice 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices and Debit Memos imported 
f rom Open Interf ace

• Inv oice batches created f or pay ment 
and ref und

• Inv oices are prepared f or pay ment

 
Invoice batches paid directly through Treasury 

Travel vouchers 
Travel vouchers with prepayments 
Travel advances 

 
Invoice batches not paid directly through Treasury 

Patient and foreign payments 
Individual TMC Charges 
Debit Memos 
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Invoice Workbench

Invoice batches can be:
Imported from other sources or
Created manually

Invoice batches may contain multiple invoices

Invoice Types include:
Prepayment (Advances)
Standard
Debit Memos (Money due to NIH)
Credit Memos (Money due to NIH)

In order for an invoice to be paid, it must be:
Validated
Free of Holds
Matched (As needed)
Accounted

AP
Invoice  

Workbench

• Inv oices and Debit 
memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment 
and ref und

• Inv oices are prepared 
f or pay ment

 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Accounts Payable Overview   
 Chapter 4 - Page 13  

Payment Workbench 

Page 11

Payment Workbench

Payments are:
Batched in AP for transfer to Treasury
Paid from the Cashiers Office and recorded in AP
Recorded in AP for reconciliation in Cash 
Management

Payment types include:
Payment
Refund

AP
Payment 

Workbench

• Pay ment batches are 
generated f or Treasury

• Pay ments and 
Ref unds are recorded 
by Cashier

• Pay ments are 
recorded f or GTA 
Reconciliation
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Travel Invoices Paid Directly by Treasury

US 
Treasury

AP Open 
Interface

AP
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Travel Invoices Paid by Cashier
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Travel Invoices for Expenses Charged by TMC
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Lesson Summary

In this lesson you learned:

• What Accounts Payable functionality is being used for 
Track 2

• How invoices are generated

• How payments are generated and recorded
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Accounts Payable Inquiry 
Chapter 5 
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Accounts Payable Inquiry 

Accounts Payable Inquiry

Track 2 End User Training
Fall 2003
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Lesson Objectives 

After this lesson you should know how to:

• Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Locating and Viewing Invoices 

After this lesson you should know how to:

Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Travel Invoices from NBS Travel Manager

Debit Memo

Standard

Standard

Standard

Prepayment

Invoice Type

Local travel vouchersTRx

Debit Memos for excess advancesTRxV#-DM
Invoices for TMC ChargesTRxV#-CB

Invoices payable to Travel upon approval of 
a voucher

Travel Advances

Invoice Description

TRxV#

TRx-AD
Invoice Name

The following invoices are interfaced from the NBS Travel Manager.

 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 6  

Travel Invoices Created Manually 

Page 4

Travel Invoices Created Manually

Debit Memo

Standard

Standard

Invoice Type

Debit memos resulting from an 
adjustmentTRxV#-DM ADJ

Invoices to refund money to a sponsorTRxV#-SR
Invoices to clear outstanding advancesTRxV#-DM-LQAD

Invoice DescriptionInvoice Name

The following invoices may be created manually as a result of a need for 
an adjustment to an already approved travel voucher.
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Travel Invoices Generated from GTA 
Reconciliation

Credit Memo

Debit Memo

Standard

Invoice Type

Credit memos for credits received on TMC fileTRxV#-CB CM GTA

Debit memos resulting from GTA 
ReconciliationTRxV#-CB DM GTA

Adjusting entries resulting from GTA 
reconciliationTRxV#-CB GTA

Invoice DescriptionInvoice Name

The following invoices may be created as a result of the reconciliation of 
the TMC file to the invoices in Accounts Payable.

 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 8  

Searching for Invoices using the Find Invoices Window 

Page 6

Searching for Invoices using the Find Invoices 
Window

Use the find invoice window to locate supplier invoices

1

2

 
•     Enter your search criteria. 
•     Select the Find button to execute your search. 
 
Note:  In order to select certain search criteria, you must select an additional criteria for the 

search.  For example, the system will not allow you to search for all paid invoices without 
first selecting a specific supplier, invoice type, or other search criteria. 

 
Selected Search Criteria 
Supplier  

Name:  Select the name of the payee from the LOV 
Taxpayer ID:  Enter the SSN or Taxpayer ID of payee 

Invoice 
Number:  Enter a full or partial invoice number or use the LOV to select a single 

invoice 
Type:  Select the type of invoice (Standard, Prepayment, Debit Memo, Credit Memo) 
Amounts:  To and From:  Enter a range of invoice amounts 
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Dates – To and From:  Enter a date range for the invoice 
Pay Group:  Select a pay group from the LOV 
Payment Method (Available as an option under drop down menu):  Select a payment 

method from the LOV 
Terms: Select the terms from the LOV 

Invoice Status 
Paid:  Select Paid, Unpaid, or Partial paid from the drop down menu 
Accounted:  Select Yes, No, or Partial from the drop down menu 
Status:  Select the appropriate invoice status from the LOV 

Holds 
Status:  Select either Held or Held/Released 
Name:  Select a hold name from the LOV 
Reason:  Defaults after selecting a hold name 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 10  

Searching for Invoices Using Query Mode  

Page 7

Searching for Invoices Using Query Mode

You may also search by using Query mode directly in the Invoices
window.

 
Press the F11 key to enter query mode. 
Enter your search criteria in any of the blue fields.  You may use the % as a wildcard. 
Press Ctrl + F11 to execute the query. 
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Invoices Window

Search results are displayed in the Invoices window.  The values displayed 
in the fields under the scroll bar reflect the invoice which is currently 
highlighted.

For invoice 
TR402V1

Use buttons to 
view invoice 
information

 
Selected Field Descriptions: 
Type:  The type of invoice (Prepayments are advances, Debit Memo and Credit Memo indicate 
that the supplier owes the NIH money) 
Supplier:  The payee of the invoice 
Supplier Number:  A unique number for each supplier 
Invoice Date:  The date of the invoice 
Invoice Number:  The number of the invoice 
Invoice Amount:  The amount of the invoice 
Payment Method:  Indicates the method by which the supplier will be paid.  If the payment 
method is check, the payment may be made in cash from the cashier if the supplier is a clinical 
center patient. 
Pay Group:  AP Advances – travel advances, Patient_Travel – patients and foreign travelers, 
Travel – other non-gta invoices 
Amount Paid: The amount paid on this invoice to date 
Holds:  Indicates the number of holds currently on the invoice 
Status:  The current status of the invoice 
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Distribution Total:  The total amount of accounting distributions for this invoice.  This amount 
should match the invoice total. 
Accounted: Indicates if the accounting transactions have been generated for this invoice.  If the 
status is No, then accounting information has can not be transferred to the General Ledger. 
 
Button Descriptions: 
Holds:  Select to view hold information 
Payments:  Select to view payment information 
Scheduled Payments:  Select to view the scheduled payments for the invoice 
Overview:  Select to view invoice overview 
Distributions:  Select to view accounting information for the invoice 
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Invoice Holds

You may view the holds that have been place upon and released from an
invoice by selecting the Holds button 
from the Invoices window.

 
In the screen shot above, you may determine that the initial Patient Recorded Pay hold was 
placed upon the invoice on September 11, 2003 by Sironj_nih.  The hold was released on 
September 23, 2003 by Cashier1. 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 14  

Invoice Distribution 

Page 10

Invoice Distribution

By selecting the Distribution button on the Invoices window,
the Invoice Distribution window is displayed.

 
The Distributions window displays the ACS value that was debited for the invoice expense.   
You may use the horizontal scroll bar to view the transaction code for the invoice. 
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Invoice Overview Window

By selecting the Overview button on the Invoices
window, the Invoice Overview window is displayed.

 
The invoice overview window displays valuable summary information related to the invoice 
include the  
•Acutal payment amount 
•Payment date 
•Payment document number 
•Active hold name 
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Invoice Payments

By selecting the Payments button on the Invoices
window, the Payments window is displayed.
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Payment Overview

By selecting the Payment Overview button on the Payments window,
the Payment Overview window is displayed.
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Practice Lab

Lab Time

 
Complete Lab 1:  Searching for and Viewing Accounts Payable Invoices 
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Locating and Viewing Payments 

After this lesson you should know how to:

• Locate and View Invoices

Locate and View Payments

• Generate Accounts Payable Reports
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Searching for Payments using the Find 
Payments Window

Use the Find Payments window to locate payments

1

2

 
•     Enter your search criteria. 
•     Select the Find button to execute your search. 
 
Note:  In order to select certain search criteria, you must select an additional criteria for the 

search.   
 
Selected Search Criteria 
Payment 

Number Range:  Enter a range of payment numbers 
Dates Range:  Enter a date range for the payment 
Amounts Range:  Enter a range of payment amounts 
Accounted:  Select Yes, No, or Partial from the drop down menu 
Document Name:  Select a document name from the LOV 
Payment Method:  Select a payment method from the drop down menu 
Batch:  Select a payment batch name from the LOV 
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Supplier  

Name:  Select the name of payee 
Number:  Select the supplier number 
Taxpayer ID:  Enter the SSN or Taxpayer ID of payee 

 
Status 

Status:  Select the payment status from the drop down menu 
Date Range:  Enter a date range 
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Payments Window

Search results are displayed in the Payments window.  User the horizontal 
scroll bar to view additional payment information.

For payment 
8000340

Use buttons to view additional information

 
Selected Field Descriptions 
Type: Batch -paid in a payment batch, Refund - refund against a debit memo, manual - paid 
from an outside system such as the CDWS. 
Document: EFT - Electronic Funds Transfer, Check - Check payment, Check.initials - Cashier 
third party draft payment, Cash.initials - cashier cash payment, USB.Recorded - recorded US 
Bank invoices for reconciliation 
Document Number:  AP payment number 
Payment Amount:  The amount of the payment 
Batch Name:  The payment batch name which is equivalent to the schedule number 
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Payment Overview Button

By selecting the Payment Overview button on the Payments window,
the Payment Overview window is displayed.
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View Invoices Button

By selecting the View Invoices button on the Payments window,
the Invoices window is displayed.
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Invoice Overview Window

By selecting the Invoice Overview button on the Invoices window,
the Invoice Overview window is displayed.

 
The invoice overview window displays valuable summary information related to the invoice 
include the  
•Actual payment amount 
•Payment date 
•Payment document number 
•Active hold name 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 26  

Invoices Window 
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Invoices Window

By selecting the Invoice button on the Invoice Overview window,
the Invoices window is displayed.

 
The Amount Paid field indicates how much has been paid on this invoice.  
The Holds field indicates the number of holds placed on this invoice 
The Accounted field indicates if the accounting transactions have been generated for this 
invoice.  If the status is No, then accounting information has can not be transferred to the 
General Ledger. 
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Practice Lab

Lab Time

 
Complete Lab 2:  Locating and Viewing Payments 
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Selected Accounts Payable Reports 

After this lesson you should know how to:

• Locate and View Invoices

• Locate and View Payments

Generate Accounts Payable Reports
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Invoice History Report 

Description: The Invoice History Report provides information to 
support the balance due on an invoice. It helps you 
quickly identify and review a detailed list of all 
payment activities pertaining to a specific invoice.

Purpose: Use this report to research payment activities related 
to an invoice

Source: Accounts Payable

Frequency: This report should be run as needed

 
Attention: Payments must be accounted before the associated payment activities are 
shown on the Invoice History Report. Run the Payables Accounting Process before 
generating this report to ensure that you are seeing the most accurate invoice history 
information 
 
Selected Report Headings 
Invoice Number:  Invoice number of the invoice. 
Payment Number: Number of the payment document that paid for the invoice. If the 
invoice has not yet been paid, this field is blank. 
Transaction Date: Date of the transaction. 
Activity Type: Activity that affected the balance of the invoice. For the invoice itself, 
this column displays the type of invoice, such as credit memo. For all the payment 
activities, this column displays what the activity is, such as Discount. 
Transaction Amount: Transaction amount in the payment currency. 
Open Balance Amount: Displays the open balance amount of the transaction in the 
payment currency. 
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Invoice History Report 

Sample report parameters:

 
Selected Report Parameters 
Supplier Name:  If you want to submit the report for one supplier, enter the supplier. Leave this 
parameter blank to submit the report for all suppliers. 
Prepayments Only 
•No. Submit this report for all invoices, including Prepayment type invoices. 
•Yes. Submit this report for only Prepayment type invoices. 
Invoice Number From/To: If you want to limit the report to one invoice or to a range of 
invoices, enter the invoice or invoice range. Leave this parameter blank to submit the report for 
all invoices. 
From/To Invoice Date: If you want to limit the report to one invoice date or to a range of 
invoice dates, enter the date or date range. Leave this parameter blank to submit the report for all 
invoice dates. 
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Submitting a Single Request 

Purpose 

The purpose of this document is to describe how to submit a single request in the NBS Financial 
Modules.  The steps will be the same regardless of the report or program that is being submitted.  
However, the request name and parameters will vary depending upon the module.  In addition, 
the navigation path may be different.  The student guide will describe the exact navigation path 
for each responsibility. 

NBS Financial Modules 

N > Requests > Run 

Submit a New Request 

 

1. Select the OK button. 

Result:  The Submit Request window is displayed. 
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2. Click on the LOV in the Name field and select the report or program you want to run. 

Result:  The Parameters window is displayed.  NOTE:  This window will be different for 
each report that you select. 

 

3. Complete the Parameters window and select the OK button. 

Result:  You are returned to the Submit Requests window. 
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If you want to run the report now for a single time, goto task #10. Otherwise, goto task #4. 

4. Select the Schedule button in the At these times block. 

Result:  The Schedule window is displayed. 
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5. Select the appropriate schedule alterative in the Run the Job... block. 

If you want to run the job once, goto task #6.  

If you want to run the job periodically, goto task #7 Otherwise, goto task #8. 

6. In the Run At field, enter the date and time you want the job to run.  The time should be 
entered in military time (24 hour clock) 

Example: 
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Goto task #9. 

7. Complete the schedule information. 

Example: 
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Goto task #9. 

8. Complete the schedule information. 

Example:   
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9. Select the OK button. 

10. Determine whether or not you want to view the report prior to printing. 

If you want to print the report before viewing it on-line, goto task #11. Otherwise, goto task 
#14. 

11. Select the Options button. 

Result:  The Upon Completion window is displayed. 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 38  

 

12. Select a printer and the number of copies 

13. Select the OK button. 

14. Select the Submit button. 

Result:  The result will depend upon the report and the schedule that you have selected.  To 
view the output of the request on line, select View > Requests from the menu bar.  This will 
take you to the Requests window. 

End of activity. 
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Saving a Report to a File 

Purpose 

This document describes how to save reports and other types of request output to files in Oracle. 

Before you begin 

Before you begin, ensure that you are located in the Requests window and the request containing 
the output you want to save is visible on the screen. 

NBS Financial Modules 

M > View > Requests 

Requests 

 

1. Place your cursor in the line of the containing the output you want to save. 

2. Select the View Output button. 

Result:  The Report - Request ID... window is displayed. 
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3. From the menu bar, select Tools > Copy File. 

Result:  A browser window displaying your report is opened. 



 

Accounts Payable Inquiry   
 Chapter 5 - Page 41  

 

4. From the menu bar, select File > Save As. 

Result:  The Save Web Page window is displayed. 
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5. Enter the file location, type, and name and select the Save button. 

6. Close the browser window. 

7. Close the Report - Request ID... window. 

8. Close the Requests window. 

End of activity. 
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Supplier Payment History 

Description: This report provides totals for the payments made to 
each supplier included in the report. If you choose to 
include the invoice details, the paid invoice's invoice 
number, date, invoice amount, and amount paid by 
the payment is displayed. 

Purpose: Use this report to review the payment history for a 
supplier. You can submit this report by supplier or 
supplier type to review the payments you made 
during a time range you specify.

Source: Accounts Payable

Frequency: This report should be run as needed

 
Selected Report Headings 
Address: Address to which payment was sent. 
Account Name: Bank account used for the payment. 
Gross Amount: Invoice amount, displayed in the payment currency. 
Payment Number: Payment document number. For example, check number. 
Payment Amount: Payment amount in the currency in which it was paid.  
Void Date: Void date if you void a payment. If you void a payment, 0.00 is displayed in the 
Functional Amount column and does not include the payment in the payment total. You enter a 
void date when you void a payment.  
Amount Paid: Amount of an invoice that you have paid. (Displayed only if you choose the 
Invoice Detail option) 
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Supplier Payment History Report 

Sample report parameters:

 
Selected Report Parameters 
Supplier Name:  Select the supplier name from the LOV 
Start/End Payment Date:  Enter the date range for the payments. 
Invoice Detail: Enter Yes to include invoice details for each payment. 
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Practice Lab

Lab Time

 
Complete Lab 3:  Submitting Selected Accounts Payable Reports 
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Lesson Summary

In this lesson, you learned how to:

• Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Supplier Inquiry 
Chapter 6 
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Supplier Inquiry 

Supplier Inquiry

Track 2 End User Training
September 2003
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Lesson Objectives 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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How the NBS Supplier Table is Utilized 

After this lesson you should know:

How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Supplier Table in Oracle

The Supplier Table is the main source of supplier information in NBS. 
Basic supplier information such as name, address, payment method, 
must be entered prior to the creation of a purchase order or AP 
invoice.
Bank information is required prior to the issuance of electronic
payments in AP.

2563 Fernw

1256 Democ

Address

HN2563C

HN2536C

Organization

Citibank152685Jane Doe

Bank of America1526354John Smith

Bank InformationSupplier #Name

PurchasingPurchasing
Accounts
Payable

Purchase Order

Traveler     $375.50

Purchase Order

Impac     $120

Supplier Table

Invoice

Traveler  $375.50

Bank of America
Invoice

Impac    $120
Citibank # 12563

 
Before a purchase order or AP invoice can be set up, the supplier must be entered into the 
Supplier Table. 
 
Before an electronic payment can be issued from AP, the supplier’s bank information must be 
entered into the Bank Table. 
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Source of Supplier Information

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Overview of Supplier and Bank Tables

NBS Travel System

Travelers

ADB

NBS Travel System

Travelers

Individuals

Companies

Supplier TableEmployee Table

Individuals

NBS Travel System

Travelers

Bank Information
(ACH)

HRDB

NED

Bank Table

1

2

3

4

5
6

 
1.  Information for individuals will be interfaced from HRDB (Human Resources Database) and 
NED (NIH Enterprise Directory) into the Employee Table. 
 

-  The process that transfers records from NED to the Employee Table will run on a 
nightly basis. 
-  The process that transfers records from HRDB to the Employee Table will run every 
two weeks. 

 
2. Individuals who are not located in either of those two systems will be entered directly into the 
Employee Table. 

-  Individuals entered into NBS directly include patients and non-nih affiliated persons. 
 
3. The process that brings information from the Employee Table to the Supplier Table and the 
NBS Travel System will run every half hour. 
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4. Vendors have been converted from the ADB.  If any new vendors are required, the request 
should be submitted to the NBRSS- Govt Acctg mailbox. 
 
5. The process that transfers ACH information from the ADB to the NBS Bank Table will run on 
a nightly basis. 
 
6. ACH information for Phoenix patients, non-NIH affiliated travelers and new sponsors must be 
entered into the NBS manually. 
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Entering New Suppliers

New suppliers will be created 
upon request from the 
payment processing office
Government Accounting must 
receive the following 
information:

Name of the Supplier
Supplier Address
Supplier Taxpayer ID
ACH Information
Supplier Contacts (optional)

Supplier Setup Request

Please set up the following
sponsor as a supplier.

The NIH will refund money to this 
organization due to overpayment.

Name: Pew Charitable Trusts
Tax ID : 253652363
Address: 1254 Lincoln Ave

Chicago, IL 45256

ACH submitted

 
The request to add a new supplier should be sent to the NBRSS – Govt Acctg mailbox. 
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NBS ACH Source and Manual Entry Process

The chart below describes the source of ACH information in the NBS.

Entry Process
IC faxes ACH Request form to Government Accounting
Government Accounting reviews request for completeness
Government Accounting enters ACH information

Traveler Type NBS ACH 
Source

Employees ADB Vendor File 
Domestic and Foreign Fellows with US bank account ADB Vendor File
Foreign Fellows without US bank account N/A
Consultants/Contractors ADB Vendor File
Committee Members/Appointments ADB Vendor File 
Bethesda CC Patients N/A
Baltimore Patients N/A
Phoenix Patients OFM
Non-NIH Affiliated Persons OFM
Foreign Non-NIH Affiliated Persons N/A
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Searching for Suppliers 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

How to search for suppliers

• How to review supplier information

 



 

Supplier Inquiry   
 Chapter 6 - Page 12  

Searching NBS for Supplier 

Page 9

Searching NBS for Supplier

2.  Enter Search 
Criteria

3.   Click 
Find

1.  Select the 
Find button

 
Navigate to N > Suppliers > Inquiry. 
•   Select the Flashlight on the Applications toolbar. 
•   Enter your search criteria in the Find Suppliers window. 
•   Select the Find button. 
 Result: Supplier Record is displayed in the Suppliers window. 
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Records for Individuals in the Supplier Table

In order to pay an individual through Accounts Payable, the individual 
must be set up as a supplier
The Supplier Name field for individuals contains their name and their 
employee number.

 
Supplier Name is equal to the Employee Name:Employee Number for individuals. 
 
Taxpayer ID field is populated with the Social Security Number for individuals. 
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Other Suppliers

OFM must maintain other supplier records such as:
Impac Government Services 
Sponsor organizations that have overpaid for travel
Other vendors
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Reviewing Supplier Information 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

How to review supplier information
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Viewing Supplier Records

Each supplier will have:
1. A header record that contains basic organizational information
2. A supplier site that contains address, banking, and contact information

1

2
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Viewing Supplier Information 

Purpose 

The purpose of this document is to describe how to view a supplier in the supplier table.  This 
document does not cover entering banking information for a supplier. 

NIH Payables User 

N > Suppliers > Inquiry 

Suppliers 

 

1. Select the Find button on the application toolbar. 

Result:  The Find Suppliers window is displayed. 
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2. Enter your search criteria as described below: 

 
Field Description 

Supplier Name Enter the supplier's name using the appropriate wildcard 
characters 

Supplier Number Enter the supplier number 
Alternate Name Enter the alternate name for the supplier 
Taxpayer ID Enter a SSN or company's taxpayer ID.   

Note:  Do not use dashes 
Tax Registration Number Enter the organization's tax registration number 

Note:  This is generally used for foreign companies 
Inactive Date Range Enter a date range during which the supplier became inactive 
Supplier Type Select the supplier type from the LOV 
Employee Name Enter the employee's name 
Employee Number Enter the employee number 
Parent Supplier Enter the name of the parent supplier 
Parent Number Enter the number of the parent supplier 
Payment Priorities Range Enter the payment priorities range 
Reporting Name Select the supplier's reporting name 
Payment Terms Select the supplier's payment terms from the LOV 
Pay Group Select the supplier's pay group from the LOV 
Reportable:  Federal Select if the supplier is reportable on a federal basis 
Reportable: Income Tax 
Type 

Select the supplier's income tax type 

Reportable: State Select the supplier's state 

3. Select the Find button. 
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Result:  Your search results are displayed in the Suppliers window. 

 

Note:  Use the down arrow on your keyboard to view your results if multiple records 
matched your query. 

4. Select the Classification Tab to review the supplier's classification information. 

Result:  The Classification region is displayed. 
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Field Description 

Type Indicates the type of supplier 
Employee Name Displays the name if an employee 
Employee Number Displays the employee number 
One Time Enabled if one-time supplier during setup 
SIC Displays the Standard Industry Code 
Minority Owned Indicates minority ownership 
Small Business Enabled if the supplier is marked a small business 
Woman Owned Enabled if the supplier is marked a woman-owned business 
 

5. Select the Sites button. 

Result:  The Supplier Sites window is displayed. 
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6. Use the down arrow on your keyboard to view other supplier sites 

7. View the address information 

 
Field Description 

Alternate Name Enter an alternate name for the site 
Alternate Address Enter an alternate address for the site 
Country Select the appropriate country from the LOV. 
Address Enter the address line information 
City Enter the city name 
State Enter the state 
Postal Code Enter the postal code 
Province Enter the province abbreviation 
County Enter the county name 
Language Enter the language used at that site 
Inactive On Enter the date the site will no longer be active 

8. Review the information on the General region tab. 

 
Field Description 

Site Uses Pay - Enabled if this site can be used for payments 
Primary Pay - Enabled if this is the primary payment site 
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Purchasing - Enabled if site can be used for purchase 
orders 
RFQ Only  - Enabled if you do not allow entering 
purchase orders for a supplier site 
Procurement Card - Accepts the credit card brands of 
your procurement cards 

Communication Contact information for this supplier site. 

9. Select the Contacts tab to review supplier contacts. 

Result:  The fields related to supplier contacts are displayed. 

 

 
Field Description 

Name: Last The contact's last name 
Name: First The contact's first name 
Name: M The contact's middle initial  
Prefix The appropriate prefix for the contact 
Title The contact's title 
Telephone The contact's telephone number 
Inactive On The date on which the contact will no longer be active 
Department The department name 
Alternate Contact Name The name of an alternate contact 

10. Select the Control tab to view any restrictions placed on the supplier's activities 

Results:  The control-related fields are displayed. 
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Field Description 

Invoice Amount Limit The supplier's invoice amount limit 
Invoice Match Option Displays the invoice match option 
Hold All Payments Enabled if you want to hold all payments to the supplier 
Hold Unmatched Invoices Enabled if you want to hold all unmatched invoices to the 

supplier 
Hold Unvalidated Invoices Enabled if you want to hold all unvalidated invoices to the 

supplier 
Payment Hold Reason Displays the reason for the payment hold 

11. Select the Payment tab to review payment information for the Supplier. 

Result:  The payment-related fields are displayed. 

 

 
Field Description 

Terms Displays the supplier's payment terms  
Pay Group The supplier's pay group can be used to segregate invoices 

in payment batches 
Payment Priority The supplier's payment priority 
Terms Date Basis The basis on which terms date is determined 
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Pay Date Basis The basis on which payments are made 
Payment Method The default payment method in accounts payable 

12. Select the Bank Accounts tab to review the bank information entered for this supplier. 

Result:  The bank account fields are displayed. 

 

 
Field Description 

Name Displays the Tax ID number of the individual or company 
Number Displays the account number 
Primary Indicates that this is a primary bank account for the supplier 
Effective Date Range Indicates the effective date of the bank information 
Bank Name and Number Indicates the bank name of the highlighted bank account 
Branch Name and Number Displays the routing number of the highlighted bank account

13. Close the Supplier Sites window. 

Result:  You are returned to the Supplier window. 
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End of activity. 
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Lesson Summary 

In this lesson, you learned:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Important Dates and 
Information 
Chapter 7 
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Important Dates and Information 

Important Dates and Information

Track 2 End User Training
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NBS Track 2 Go-Live

September 1, 2003
NBS Travel System and supporting 
financial modules were deployed for 

entering FY04 travel documents

October 1, 2003 or when FY04 
funding is available

Financial transactions resulting from FY04 
travel documents will be processed
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Initial Oracle Set Up Required

The first time you log into the NBS, you will be required to:
Download Oracle J-Initiator and
Update your internet browser security settings

Refer to the technical guidance provided on the NBS
Technical website:http://nbs.nih.gov/technical.html
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NBS Travel Support Resources

NBS Travel Web links available 24/7
NBS Oracle Online Help and Ref erence:  http://nbs.nih.gov/training.html

NIH Portal Support
Phone NIH Help Desk at 6-HELP (301.496.4357)
Portal website address:  http://my.nih.gov

NBS Customer Support
Phone: Call 5-NBS7 (301.435.6277)
E-mail: Send e-mail to tasc@NIH.gov

Web Request f or Support: Submit to: http://support.cit.nih.gov

nVision
nVision is an ev olution of  the NIH Data Warehouse, and it is the new reporting sy stem designed 
to work in concert with the NBS. nVision is a business intelligence system that deliv ers NIH-
def ined standard reports and f acilitates the dev elopment of  user-created ad hoc reports to 
support decision-making and analysis. The f irst NBS module to be supported by  nVision is 
Trav el.
E-mail: Send e-mail to nVisionSupport@nih.gov

Web Site f or inf ormation: http://nvision.nih.gov
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Evaluation

Please take a moment to complete the 
on-line training evaluation

www.surveymonkey.com/s.asp?u=44111257699

Your comments are important to us!

 



   

Important Dates and Information   
 Chapter 7 - Page 7  

Good Luck 

Page 5

Good Luck

Good Luck!
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